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Introduction
The Kinetic Studio software package provides a wide range of facilities within a friendly, familiar
format that is easy to use.

Kinetic Studio is primarily designed for the acquisition, analysis and management of kinetic data
associated with the Hi-Tech Scientific instruments for transient kinetics. It is a feature rich
package that provides an efficient and intuitive means of managing instruments in the laboratory
and speeds data processing by providing a host of data handling and visualisation facilities. These
include an array calculator, logarithmic time-base and high-speed graph plotting as well as
offering automated modes of instrument operation for rapid and reproducible throughput of
experiments. An oversampling function allows data points to be averaged, improving signal to
noise and resolution.

Kinetic Studio also includes a data file converter which brings compatibility with other, third party
instruments for spectroscopy and popular data processing packages.

Health and Safety at Work Act, 1974 - UK
In accordance with the above Act, we ensure that all products manufactured or supplied by TgK
Scientific Limited are safe and without risk to health when used by suitably trained personnel
following our instructions.
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Installing Kinetic Studio
Kinetic Studio is made to run on computers running Windows 7 or Windows 10. The software
may function on other versions of Windows however some functionality may be lost.

Installations involving instrument control or data acquisition managed by Kinetic Studio involves
the installation of computer hardware devices. Please follow the guide relevant to the equipment
supplied.

If a USB / PCI based Counter Timer card or Data Acquisition card has been supplied and is already
fitted within the computer, Windows may display a ‘New Hardware Found’ message. Please cancel
these messages.

The Kinetic Studio installer as part of the installation process will install the device drivers
automatically.

If hardware devices cannot be found or do not install correctly, please check the Device Manage
(accessible from the right click menu of the windows button). If there are any unknown devices,
please remove them and reboot the computer.

If the supplied cards are not yet installed, please switch off
the computer and install them now taking note to cancel any
new devices found messages when the computer is started.

For single file installations, the setup program will unpack
itself and prepare the PC for installation. For DVD
installations, the installation process should start automatically. If not, please explore the DVD
and run the kineticstudio_#.##.exe executable.

If there are any required components that need to be
installed into the operating system, these will be shown as
below. Click 'Next' to begin the installation.

Once this has completed, installation of the main Kinetic
Studio application and related drivers will commence. Click
'Next' to proceed.

Click 'Next' to begin the installation.
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After agreeing to the terms and conditions, the installer will ask which modes of operation are
required. Please select the required modes. SF-61DX2 users will need to select KinetAsyst
Stopped-Flow as a minimum.

The Data Analysis option provides a quick shortcut to bypass any hardware scanning and go
directly into the data analysis mode.

The next screen will prompt for the instrument temperature range. The default, -40 to +60 is
suitable for most KinetAsyst Stopped-Flow instruments.



Installing Kinetic Studio

©TgKScientific Limited, 2018 12

When prompted for the type of installation, please choose 'Complete'.

Generally it is recommended that Kinetic Studio is installed to the default directory.
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The main Kinetic Studio program files will now be installed...
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Driver Installation
The next stage of the installation process allows the user to select required device drivers. These
are required for controlling the instrument and acquiring data.

USB / PCI Counter Timer Cards
Skip to the Data Acquisition driver section if there is not a Measurement Computing counter timer
card present. Systems built in 2014 or later will not have a Counter Timer Card.

The first option is to install the Counter Timer card driver.

Please select the option and continue (if the counter timer card is present).

Depending on the operating system, the new driver dialog may be shown. Place a tick in the
'Always trust software from "Measurement Computing Corporation" and 'Install' the device
software.
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Data Acquisition Card
The next option is to install the high speed data acquisition drivers. If no hardware is present
select 'Skip this step'.

For systems made before 2014 select 'Install DT3010 Acquisition Drivers'. For systems made in
2014 or later select ' Install National Instruments DAQmx Drivers'.

Press 'Next' to continue.

Depending on the operating system and the driver selected, the new driver dialog may be shown.
Place a tick in the 'Always trust software from "data translation" and 'Install' the device software.
On a 64bit version of Windows, both the 32bit and 64bit drivers need to be installed so the dialog
may appear twice.
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Post Driver Installation
The installation is nearly ready.

Click 'Finish' to complete to installation.

The installer will display the following message if drivers have been installed.

Please read the message and make sure all open work is closed. Then click the [OK] button. This
will reboot the computer.

When the computer has rebooted, new hardware may be found by the operating system
(depends which version of Windows).
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The drivers have been installed by the Kinetic Studio installer so Windows will find them
automatically on the hard disk.

Initialising the Counter Timer Card Ready for Use
If the counter timer card has been installed please run the Instacal program which will have been
automatically installed.

Instacal initialises the Counter Timer card ready for use. The program can be found in the Start
Menu under Measurement Computing. Once started, Instacal should automatically find the card.
It will then display a summary, after which Instacal can be closed. The computer is ready to run
Kinetic Studio.

Upgrading Kinetic Studio
If an new version of the Kinetic Studio Installer is run while an old version of Kinetic Studio is
installed on the PC, the old version will be uninstalled before the new version is installed.

Once the uninstall is complete follow the instructions for Installing Kinetic Studio on page 10.
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Starting Kinetic Studio
Launch Kinetic Studio from the icon on the desktop or the program icon in the Start Menu.

During software installation, a shortcut to a folder named 'SF Data' is created
which is located in the 'My Documents' folder by default. The location of this file
can be changed within Kinetic Studio.

To perform hardware troubleshooting, double-click the 'Engineers Toolkit' icon.

Other shortcuts will have be created for other modes if selected during installation.

On launching the software, the main Kinetic Studio start-up screen will be displayed. This will
display the initialisation steps (depending on the version of Kinetic Studio)

If Kinetic Studio is unable to verify the equipment is present or there is a communications
problem, it will default to emulation mode.  Emulation mode will allow the software to be used for
data analysis.
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Kinetic Studio Overview
Introduction
When Kinetic Studio has fully loaded, a screen similar to the following will be displayed:

The red circle is highlighting the 'New Document' icon and the 'Acquire'menu.

The 'New Document' icon will display the control panel.  The control panel can also be opened
from the 'Acquire'menu or by pressing 'F8'.

The control panel that appears will depend on the installed option or options and modes of
operation available for the available system.  The following shows the most common examples:
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KinetAsyst Stopped-Flow Photomultiplier Control Panel

Conductivity (Stopped-flow) Control Panel
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T-Jump Control Panel



Kinetic Studio Overview

©TgKScientific Limited, 2018 22

The Workspace
An example workspace is shown below:

If there is a problem at start-up, red indicators at the
bottom of the screen will be visible.  Hover the mouse
over the indicators to provide additional information.

Please Note: In 'Conductivity'mode, certain of these
indicators will be red since the instrument is not being
controlled.

Kinetic Studio features a real-time progress dialog for
longer run times.

Where using photomultiplier detection, linear time
base, shots over ten seconds automatically enable the
real-time display. 
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Navigating Kinetic Studio
Zoom
To zoom in on a Chart, press the left mouse button at the top left hand corner of the area to zoom
in on and maintaining the mouse button pressed, drag out the rectangle to the bottom right-hand
corner of the zoom area. Release the mouse button and the Chart will redraw the area selected.

To undo the zoom, press the left mouse button anywhere on the Chart area and drag up and left
with the mouse button depressed. Release the button and the Chart will redraw to the originally
defined Chart area. Alternatively use the context menu to select the 'Autoscale All…' option.

Scroll
To scroll a Chart across, press the right mouse button and maintaining the mouse button pressed,
drag the mouse in the desired direction to scroll the Chart. After releasing the mouse button the
Chart will remain at the new location.

To undo the scroll, press the left mouse button anywhere on the Chart area and drag up and left
with the mouse button depressed. Release the button and the Chart will redraw to the originally
defined Chart area.

Identify a Trace
There are two ways to identify a given trace. A known trace can be selected from the legend
which will highlight it in the graph area. Alternatively use the mouse pointer and then press the
middle mouse button whilst hovering over the unknown trace. This will both temporarily
highlight it and select the trace within the legend panel.

Extract Trace Under Mouse
To extract a trace quickly and easily from the chart view, move the mouse cursor over the trace
and then using the context menu (right mouse button), select 'Extract Nearest Trace...'.

Available Chart Context Menu Features
There are a number of facilities available via the chart context menu (right mouse button).

Most of these features are self-explanatory. Here is a quick summary of some of the key items:

Autoscale All

Reset the zoom to normal ensuring all of the data is visible on both the X and Y axis.

Fix X-Axis

This will prevent the X-Axis from changing. This applies to both new shots and viewing existing
data. When enabled it will fix the X-Axis to the current settings.
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Fix Y-Axis

This will prevent the Y-Axis from changing. This applies to both new shots and viewing existing
data. When enabled it will fix the Y-Axis to the current settings.

Sticky Cursor

Enabling this option will display a large cross-hair in the same colour as the currently selected
trace. When enabling the option it will use the nearest trace to the mouse cursor. The trace will
also be identified in the status bar at the bottom of the screen.

To move between traces, use the keyboard cursor up and down keys. This will scroll through the
traces.

Find Nearest Trace

The nearest trace to the mouse cursor will be identified and highlighted.

Extract Nearest Trace

The nearest trace to the mouse cursor will be identified and extracted into a new dataset.

Add Annotation

An annotation can be added to the current cursor position.
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Properties

The properties option will display the graph options.

Graph Options

There are a number of graph options that allow the chart view to be customised. This includes
trace colours, line width, graph title, axis titles and more.

The main options panel allows the trace to be displayed as a line, as points, or a combination of
the two by enabling lines and markers.

If a higher quality view of the display is required, the high quality anti-aliasing option can be
enabled. Please note that this will slow down the chart display - particularly with large datasets
such as CCD data.
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How Data is Displayed
All data held in memory when initially created, whether it be from an acquisition, or loaded from
disc, is given a small representation situated in the left portion of the Kinetic Studio window. This
small window is called a thumbnail, and is an integral part of the software for the display and
manipulation of data.

Taking a closer look at a thumbnail, it can be seen that it
comprises of three elements.

The top title section provides information such as:

(DS274): dataset number.
*: Indicates the dataset is currently unsaved.
Additionally if the dataset has been fitted, this will be
indicated in the title.

The graph represents the first few traces within a dataset.

The text at the bottom of the dataset is the filename.

The thumbnails can be resized according to the users’ preference.

Pressing the 'Options' button at the top of the thumbnail panel will display the following dialog.
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Selecting a Single Thumbnail
A single thumbnail can be selected by using the mouse. Simply move the cursor over the
thumbnail and click the left mouse button.

DS275 represents and unselected thumbnail.

DS276 is shaded in black representing a selected thumbnail.

Selecting Multiple Thumbnails

Multiple thumbnails can be selected with the mouse.

This is done in one of two ways:

Selecting a group of thumbnails together can be achieved by clicking on
the first thumbnail with the mouse and then click on the last thumbnail in
the group whilst holding the 'SHIFT' button on the keyboard.

Selecting individual thumbnails together can be achieved by clicking on
each thumbnail with the left mouse button whilst holding the 'CTRL' key
down.
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Displaying a Single Dataset
A single dataset can be displayed by double clicking the thumbnail or by right clicking on a
thumbnail and selecting the option to 'Display'. A single trace, when displayed, will have its
thumbnail turn red, or green if another thumbnail is selected.

Overlaying Multiple Datasets
To overlay multiple datasets, firstly please select multiple thumbnails using the method above.

Next, right click on one of the selected thumbnails to display the context menu.  From there select
the 'Display' item.
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Data Manipulation – Analysis, Fitting, Management
Data analysis functions can be found in the Tools menu.

The functions available will depend on the type of dataset.

Calculator
The dataset calculator allows traces or constants to be added, subtracted, multiplied or divided
into a trace.  The resulting trace can replace the original, be added to the dataset or added to a
new dataset. More information can be found in Dataset Calculator on page 128.

For convenience conversion operations can be quickly accessed via the 'Convert' sub menu.
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Analysis Control Panel
Data analysis functions can be found in the 'Tools' -> 'Analysis'menu, by pressing the key
combination 'Ctrl' + 'F' or by selecting the fitting icon from the toolbar:

The 2D / 3D / Analysis results view can be selected at the lower part of the screen as highlighted
above in red.

Kinetic Studio will ask which trace to fit.  This is done by
displaying a summary screen of all datasets in memory.

After selecting the trace, the Analysis Control Panel will be displayed.
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For further information about data fitting, please seeData Fitting on page 137.
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Dataset File Management
How to Change the Current Working Folder
To set the current working folder, i.e. the folder in which all subsequent files will be saved, go to
the 'File'menu and select the 'Set Working Folder' option.

This will produce the following window:

Choose the drive and folder to use, and select the 'OK'
option.

This folder will be used whenever the user wishes to load
or save files and will be remembered when Kinetic Studio
is next launched.
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How to Save Data
To save data items to disk, either use the 'Save' option from the 'File'menu, or use the toolbar
button, which resembles a floppy disk. The status bar at the bottom of the main Kinetic Studio
window will display the progress of the saving process.

To save all the datasets to disk, use the 'Save All' button, the stack of disks, either on the toolbar
or in the 'File'menu.

To save the file with a specific filename or to a specific location, use the 'Save As…'menu item. 
This will display a standard save dialog allowing the data to be saved on the local machine,
network or an external drive.
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How to Export Data or Fit Results
Exporting data is very similar to saving a normal dataset. 

If fit results are required to be exported, there is a dedicated menu item entitled
'Export Fit Results' within the 'File'menu.  The original trace, fitted trace and residuals are all
saved.

Standard datasets can be exported to text files, comma delimited or SPECFIT XYZ files as
standard.

It is important to make sure the correct 'Save as type:' option is selected.  Next, enter the
filename and click the 'Save' button.
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How to Export to SPECFIT/32
Within Kinetic Studio a dataset can be saved as a number of different types. Convenient support
for comma delimited SPECFIT/32 files has been included within the software.

To Export a dataset ready for SPECFIT/32, go to the 'File'menu and select 'Save As...'.
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Within the dialog change the 'Save as type' to 'Specfit XYZ Files'.

Finally set the 'File name' and click 'Save'.

Within SPECFIT/32 there are two ways of loading the file that has just been saved. Both methods
will be outlined below.
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Importing into SPECFIT/32 Method 1

SPECFIT/32 features an import system which can be used to quickly and easily load the data
exported from Kinetic Studio.

To access this system, go to the {Import} menu and select {3D Kinetics Files}. This will
display the following screen:

Navigate to the folder containing the exported Kinetic Studio SPECFIT XYZ file using a '*.CSV'
search pattern as above. Make sure the Import Converter is set to:

'ASCII-XYZ .TXT SPECFIT spreadsheets'

Press 'Import Files' to begin the import process.
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The following dialog will be displayed:

Please review the parameters on this form. If Diode Array data is present, check the Wavelength
Limits in the event the data should be windowed / cropped.
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Importing into SPECFIT/32 Method 2

Within SPECFIT/32, go to the 'File'menu and select 'Read ASCII File'.

Browse to the exported Kinetic Studio SPECFIT XYZ data file and press 'Open'.
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The data file should now be loaded into SPECFIT/32. The next step typically involves Factor
Analysis. To do this, select the 'Factor Analysis' item from the 'Calculate'menu.

Select 'Analyse Current File'.

Proceed to select Kinetic Fit from under the Model menu item.
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For additional help with SPECFIT/32 please consult the SPECFIT manual.
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ReactLab

Multivariate Analysis and Reaction Modeling of
Chemical Processes from Jplus Consulting.

Web site: www.jplusconsulting.com/

The ReactLab family of products currently comprise
two software applications for the modeling and
analysis of multivariate spectrophotometric chemical
process data. These Windows applications enable
the global fitting of such data to chemical reaction
schemes in order to establish and quantitatively
analyse the underlying reaction mechanism yielding
all the reaction rate constants and equilibrium
constants as well as the concentration profiles and
spectra of all intermediate species.

Convenient support for export to ReacLab™
KINETICS software has been included within the
software.
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Exporting from Kinetic Studio into ReactLab
With the dataset to be exported open, select the 'Tools'menu from the top of the screen. Next
choose 'Analysis'->'ReactLab'.

This will open the 'ReactLab Export' window. If ReactLab has previously been configured, the
'ReactLab - Quick Export' facility can be used to speed up the export process of multiple
datasets.
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The first time the export to ReactLab facility is used, it must be configured with the appropriate
paths. This tells Kinetic Studio where the ReactLab program resides and which ReactLab template
should be used for data export.

To change the paths, either select the appropriate menu item from the 'Settings'menu or press
the file path and template verification buttons. This will present a file browser dialog to locate
either the ReactLab executable and / or the ReactLab Excel template that should be used for data
export.

Prior to exporting the data, the dataset can be cropped if necessary using the 'Crop' option under
'Tools'.

Once the dataset is ready for export, simply press one of the [Export] buttons.

The data will be exported into the Excel ReactLab template and saved to a new location chosen via
a standard Save File dialog.

For convenience the filepath is copied to the Windows Clipboard for quick pasting into the
ReactLab open file facility.

Tip: Pressing the key combination CTRL-V simultaneously will paste items from the clipboard.
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How to Load a Dataset
Opening data items can be achieved by either using the 'Open…' option from the 'File'menu, or
by using the toolbar button. This will produce the following dialog:

This will initially display the current working folder. Navigate to the drive and folder where the
data is located, and select one or more files from the list.
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How to Import Data
Importing data is very similar to loading a standard dataset.  ,

Kinetic Studio can import text files, comma delimited files and older KinetAsyst files.

Choose 'Open', as above. Change the 'Files of type:' drop down list to the file type of choice
and select a file or files from the files list.

Once data has been selected, the Data Types dialog appears. Choose the relevant Signal and Axis
Types and press 'OK'.

If Kinetic Studio successfully imports the data, it will appear within the thumbnail panel and
automatically display the data in the main graph view.
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Stopped-Flow; Initial Setup and Getting
Started

Before beginning to collect data, it is necessary (as with any spectrophotometer), to set up the
optical signals so that the analogue signals fit within the operating range of the A/D converter and
so that measured signals can be interpreted (where appropriate), in absorbance units.

These guidelines to setting up for optical measurements can generally be applied across the range
of techniques supported by Kinetic Studio (i.e. Single and Double Mixing Stopped-flow,
Temperature-Jump).
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Photomultiplier
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How to perform a Scan Blank (Absorbance)
This mode allows users to set up for absorbance measurements to be taken over a range of
wavelengths and are thus able to acquire kinetic data at different wavelengths and/or acquire
single scans to characterise reagent spectral information.

When the system is configured for absorbance measurements, before acquiring new data it is first
necessary to align and focus the optics, set the correct photomultiplier voltage and scan a blank. 
Scanning a blank involves the monochromator scanning a wavelength span acquiring 100%
(maximum incident light) and 0% (dark condition) transmission reference levels.

Before performing this operation, ensure that the optical cell contains pure water or a buffer
solution.

To perform an auto-setup scan blank, perform the following steps:

Press the 'Spectrometer' button to enter the manual setup mode. 
This will display the 'Photomultiplier Setup Wizard'.

Next the dialogue will offer choice of a scanned set up and a manual set up.  The former invokes
the use of a scanned blank over a user selected wavelength range, the latter provides for users
content to set up at just a single wavelength.

A scanned blank is appropriate for absorption studies only; the manual set up can be used for
absorption and fluorescence.
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Here, we will begin with selecting the 'Set up and scan a blank' to begin the wizard driven
setup. The 'Lamp Settings' panel enables the user to select the lamp currently within the
system.  This in turn automatically fills the wizard with typical wavelength ranges, optimisation
and alignment wavelengths for the blank.

The first step is to select the lamp currently fitted to the system.

If the typical values for the wavelength range are not suitable or require adjustment, please edit
the desired start and end wavelength spans for the lamp.
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To ensure optimal distribution of the signal over the scan blank wavelength span, the user should
optimise the optics at one wavelength, and then maximise the PM volts at another wavelength. 
This is especially critical when using a wide wavelength span. 

To restore the default values for a particular lamp use the 'Set Defaults' link.

It is often convenient to set the lamp optimisation wavelength to suit the wavelength range where
absorbance changes are to be studied. 

The edit field labelled 'PM Volts' is the wavelength where the PM volts are maximised; this
ensures that the maximum signal span is achieved under normal circumstances.  With the Xenon
and QTH lamps, this is set at 480 nm as this is where the system exhibits a maximum signal.

Once the lamp and wavelength ranges have been set, please press the 'Next' button to proceed
with the first stage of optimisation.

As the 'Optical Alignment' page appears the monochromator will move to the specified ‘Optical
Alignment’ wavelength as specified on the previous page of the wizard.
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To perform the optimisation, open the PM-61s photomultiplier shutters and adjust the PM Volts
for the main channel (green trace), the reference channel (red trace) and, if applicable, the
auxiliary channel (grey trace), increasing the signal at the Live Display to about 50.  This is simply
used as a mid-point to allow for positive and negative shifts when the optics are adjusted.

Follow the procedure for optimising the optical components as described in the Section 4 of the
SF-61DX2 User Manual.  In brief, adjust the lamp position and its alignment.  It may be necessary
to adjust the PM volts for the particular channel should the signal saturate.

After finishing the optimisations, return the signal level back to 50 on the Live Display, this is
simply used as a relative indication of signal level when moving to the next wavelength.

As the 'Photomultiplier Voltage Adjustment' page appears, the monochromator will move
to the adjustment wavelength as specified previously. 

Increase the PM Volts for the relevant channels, so setting the signal level(s) to about 80% full
scale.  You must ensure that the signal does not saturate, i.e. go above 100% full scale.

As a quick check it is worthwhile clicking the '< Back' button to ensure the signals are not
saturated at the previous wavelength where the optical optimisation was performed.  If they are
saturated, go to the next page and lower the PM Volts for the relevant channels.

This concludes the optimisation process.  Clicking the 'Next>' button will present the 'Scan
Blank' page.
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Scanning the Blank

The scan blank process is fully automated. 

The process will begin with a full monochromator re-calibration.

The scan blank process consists of scanning a baseline with no light (0%) and with the filter
wheel open (100%). Whilst traversing through the wavelength range, the system will
automatically insert appropriate filters.

After both the 0% and 100% scans have completed, the system will acquire static baseline
references and present the 'Set Up Completed' panel.

The system is now ready for use.
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An example of a scan blank collected with the xenon lamp:

Here are a couple of additional example reference data sets:
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How to set the Reference / Signal Levels at a Single Wavelength

This mode allows users to set up for absorbance or fluorescence measurements at a single
wavelength. Typically this would represent setting the excitation wavelength for fluorescence
mode and a simple single wavelength mode for absorbance studies.

Press the 'Spectrometer' button to enter the manual setup mode.  This will display the
'Photomultiplier Setup Wizard'.

Select the 'Manual setup and references' to begin a manual setup.
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The manual setup panel will be visible along with the live display.  This allows the user to change
wavelength and read signals for both 0% and 100% for each channel.

When used for absorbance measurements, 100% (maximum incident light) and 0% (dark
condition) transmission reference levels are required to be recorded for a single wavelength.
When used for fluorescence measurements, this single wavelength is the excitation wavelength
and although reference levels can be acquired, normally the Live Display is used simply to
maximise the fluorescence signal by optimising the optics and maximising the PM Volts at this
wavelength.

Simply exiting the setup dialog by pressing 'Next' and 'Finish' enables data collection at the set
wavelengths.  Often fluorescence measurements are made without any set references.
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General usage instructions for manual setup

1. Enter the monochromator wavelength into the 'Wavelength' box.  This is then set and
recorded for each subsequent shot.

Note: Ensure the correct optical filters are in place if required (eg fluorescence emission).

2. The Monitor or live display accompanies the manual setup dialog in order to view the
signal levels for each of the enabled detector channels. 

Manual Setup for Absorbance
1. Ensure the flow circuit and in particular the observation cell is flushed and as such contains

water or buffer solution.

2. Optimise the optics for maximum signal.

3. Increase the PM Voltage for the relevant channels until the signal trace approaches 80%
span.  Remember for older instruments, an increase in light intensity manifests itself as a
decrease in signal level. Note that the Main and Reference Channels must be set.

4. Collect the 0% reference data by either pressing the button(s) next to each channel in the
0% column or enter them numerically, or press the 'Read 0%' link to collect for both
channels. Remember to shutter the light manually for 0% reference levels.- only older
stuff.

5. Collect the 100% reference data by either pressing the button(s) next to each channel in
the 100% column or enter them numerically, or press the 'Read 100%' link to collect for
both channels. Remember to open the shutter to light manually for 100% reference levels.

Note:  As mentioned older instruments may have inverted voltage levels displaying a high
reading for 0% and a low reading for 100%. 

6. Once the values have been read, press the 'Next' button to complete the manual reference
wizard.  Then click 'Finish' to return to the main control panel.
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Manual Setup for Fluorescence
The user will need to have prior knowledge of the expected fluorescence change, whether it is
increasing or decreasing with time.

If the fluorescence is increasing

1. Load both reagents into the Sample Handling Unit and mix by doing a few shots. After an
appropriate time, the contents of the optical cell will now give a fluorescent signal
comparable with the maximum fluorescence at the end of the reaction.

2. With the appropriate filter(s) fitted to the photomultiplier(s), open the shutter(s) and apply
PM Volts until the signal level responds.

3. Optimise the optics for maximum signal. The user should note a few points here: the
fluorescence may decrease due to photo bleaching – replenishing the cell contents
periodically will offset this problem, however, the timescale of the bleaching process is
probably an unknown factor here. Secondly, the excitation wavelength can be adjusted to
find maximum response, especially when using line sources such as mercury lamps.

4. Increase the PM Volts to set the signal level close to an 80% span. Remember for older
instruments, an increase in light intensity manifests itself as a decrease in signal level.
Note: Reference channel must be set – usually in Single Beammode for fluorescence and
will appear at just above 80%.

5. If desired, the user can record the fluorescence reaction 0% and 100% levels, by first
selecting the 'Read 0%' button and recording the 0% level, remembering to shutter the
light and then selecting the 'Read 100%' button and recording the 100% level ensuring
any light shuttering used is open.
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If required, the dialog can be closed to enable data acquisition by selecting the 'Next' and then
'Finish' buttons to exit.

If the fluorescence is decreasing

1. Load the fluorescent reagent into the Sample Handling Unit and mix it with buffer by doing
a few shots. The contents of the optical cell will now give a fluorescent signal comparable
with the initial fluorescence of the reaction.

2. With the appropriate filter(s) fitted to the photomultiplier(s), open the shutter(s) and apply
PM Volts until the signal level responds.

3. Optimise the optics for maximum signal. The user should note a few points here: the
fluorescence might well decrease due to photo bleaching – replenishing the cell contents
periodically will offset this problem, however, the timescale of the bleaching process is
probably an unknown factor here. Secondly, the excitation wavelength can be adjusted to
find maximum response, especially when using line sources such as mercury lamps.

4. Increase the PM Volts to set the signal level close to an 80% span. Remember for older
instruments, an increase in light intensity manifests itself as a decrease in signal level.

5. If desired, the user can record the fluorescence reaction 0% and 100% levels, by first
selecting the 'Read 0%' button and recording the 0% level, remembering to shutter the
light and then selecting the 'Read 100%' button and recording the 100% level ensuring
any light shuttering used is open.

If required, the dialog can be closed to enable data acquisition by selecting the 'Next' and then
'Finish' buttons to exit.
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Fluorescence Excitation Scanning

Kinetic Studio should be started in fluorescence
scanning mode. Normally this is done by
clicking on the 'Fluorescence Scanning' icon
installed along side the standard Kinetic Studio
icons. If this is not visible, please either re-
install Kinetic Studio placing a tick in the
'Fluorescence Scanning' option or manually
create an additional icon and add a command
line entry of /flscanning.

When enabled, the control panel will indicate it's running in 'Fluorescence Scanning' mode.

The control panel is ready to be used. A wavelength can be entered into the 'Wavelength' field.

Alternatively if zero order is required, please enter 0.
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Fluorescence Emission Scanning

Kinetic Studio should be started in fluorescence
scanning mode. Normally this is done by
clicking on the 'Fluorescence Scanning' icon
installed along side the standard Kinetic Studio
icons. If this is not visible, please either re-
install Kinetic Studio placing a tick in the
'Fluorescence Scanning' option or manually
create an additional icon and add a command
line entry of /flscanning.

When enabled, the control panel will indicate it's running in 'Fluorescence Scanning' mode.

The control panel is ready to be used. A wavelength can be entered into the 'Wavelength' field.

Alternatively if zero order is required, please enter 0.
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Setting the Data Type and Dataset Parameters
Note the default data type is Transmission on Channel 1.  To change this or set up for multi-
channel acquisition, the user should configure which channels should be enabled and set the data
type.

Configuring the correct data type is essential as this dictates some of the data processing
immediately after a shot and indeed how the data can be subsequently manipulated.

The 'Data Type' options are:

l Unknown
l Transmission
l Fluorescence
l Light Scatter
l Conductivity

The 'Modifiers' available are:

l Unknown
l None
l Polarisation
l Anisotropic Polarisation

Each channel can be enabled by checking or unchecking the 'Enabled' checkbox. (Note that this
function mirrors the channel select boxes on the main control panel).

The number of data points can be increased or decreased resulting in more or less detailed
datasets.  Typically, the default setting of 512 is recommended and widely used – users are
encouraged to keep this default setting until they are confident that they understand the
consequences of the more advanced settings.

Oversampling helps to increase the quality of data and resolution.  It has the ability to increase
signal to noise by collecting number of data points and averaging them together.  Typically this is



Photomultiplier

©TgKScientific Limited, 2018 67

set at 48 but it can be increased or decreased depending on the experiment.  For T-Jump
acquisitions speed tends to be priority so often the oversamples may be set to 1.

Pretrigger can be configured as a percentage of the run time prescribed. (This advanced feature
allows observation of the flow time prior to stopping in stopped-flow acquisitions).

Executing a Shot
With the instrument set up with appropriate optical signal levels, the user can start to collect data.

Important: At this stage it is important that the instrument is filled with reagent
or left with buffer or water in the flow circuit, the drive syringes should be in
contact with the push plate(s) and generally ready for operation.  All instructions
and cautions detailed in the hardware manual should be observed.

The user’s attention in drawn to a further examination of the Acquisition Control Panel:

The following features should be noted and considered  for the shot:

'File Name': The user should provide a filename which will enable them to identify their data. 
An File Number will be added to each file name and will increment with acquisitions.  Data will be
saved to the working folder set under the File menu item.  Data collected will default to “data…”
until set by the user.

'Auto-save': Defaults to not enabled – check the box to set.  This is not necessarily
recommended until the user the is quite happy that collected data are as required – it can be too
easy to store lots of priming and false shots!
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'Notes': While many users are quite happy to identify their data by file name and folder this
feature allows a text window to open which can be used to further enhance identification of
experimental conditions etc and any user input comments. Leave blank by default if not required.

'Convert to absorbance': This option should be checked when the data type is
transmission/absorption and the user would like their data converted to absorbance units directly
upon acquisition.  Note other data types such as fluorescence will inhibit this selection.

'Logarithmic timebase': should be eanbled if the user wants the acquisition time base to be
logarithmic (ie not linear).  Ideal for multi-phasic observations; not good for fast time bases, lag
phases, inexperienced users. Leave unchecked if unsure about this. The setting is available under
the 'Options'menu.

More explanation is given later in this section for these features – at the moment, it is best to
simply concentrate on getting going …

To do a shot …

Select the Wavelength and the Run Time to be used for the measurement then use the Single Shot
button and the user should observe the emptying of the Stop/Waste syringe followed by the
actuation of the air drive to effect a stopped-flow mixing shot.

To scan the contents of the cell …

Hit the Single Scan button and the monochromator will slew between the Start and End
wavelengths shown below this control revealing the spectrum of the reagent or product.

In the following, more detail is given for those users wishing to take advantage of the more
advanced features relating to data set parameters...

Optimising the Dataset Parameters
For many users, the setting up Kinetic Studio for an experiment is to configure the number of data
points required, oversampling and pretrigger.

The number of data points relates to the final dataset and graph.  This can be adjusted depending
on the experimental requirements and trace detail.  The typical number of data points used in an
experiment is 512.

Oversampling can be used to improve signal to noise and hence the quality of data.  For every
data point, oversampling corresponds to the number of additional samples that are averaged
together. 

For example, the screenshot above shows 512 data points have been specified with 48
oversamples.  This means the data acquisition device will acquire 512 x 48 samples (24576
samples in total).  Every data point is an average of 48 samples.  The software will automatically
perform the averaging after the experiment has completed.

Highlight
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Pretrigger can be used to acquire data just prior to the trigger point.  The amount of pretrigger is
specified as a percentage of the run time.

Setting the Run Time
The experimental run time can be manually entered by editing the 'Run Time' numeric box or
alternatively a series of standard run times can be applied by clicking the small up and down
arrows next to the 'Run Time' box.

For shots requiring a log acquisition and hence being displayed with a logarithmic x-axis, the
'Logarithmic timebase' option can be enabled.  The standard log timebase applied is 10 log
cycles with 64 points per log cycle.  Kinetic Studio intelligently uses the additional samples
acquired for logarithmic processing to apply data averaging improving the signal to noise.

Should the experiment require it, a custom log mode facility can be accessed by pressing the link
'Logarithmic timebase'.  This will display a log parameter editing utility as shown.

If the Conductivity device being used is an option for the Stopped-Flow system, the ability to edit
the 'Age-Time' will be made available. 

Specifying a file name
Within the 'Data Set File Name' area to the bottom left of the control panel, enter a file name
that corresponds to the experiment being performed.  If required (generally recommended),
create a folder for the group of experiments being performed and save all related data into that
folder.

Kinetic Studio provides a convenient facility to specify a working folder.

Please consult the 'How to Change the Current Working Folder' subsection within the
'Dataset File Management’ section.
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Adding Notes to a Dataset
Clicking the 'Set Notes for Dataset' in the 'Notes'menu of the control panel will display a
small notes editor.

The notes editor provides a facility to save experimental
information or comments with a dataset.  These notes will be
applied to every shot.

Notes for a given dataset can be displayed and edited by selecting the 'Notes'menu item under
the 'Graph'menu as shown below.
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CCD Array

Launching Kinetic Studio in CCD / Spectrometer Mode
When Kinetic Studio starts in one of the CCD modes it will automatically detect the connected
device. If it is unable to find a supported CCD device an error message will be displayed in the log
window at the bottom of the screen.

If a CCD device is successfully detected, Kinetic Studio will initialise the device and run some tests
to confirm functionality and performance. Please wait for these tests to complete.

Once the tests have finished the software is ready for use.
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To start using the CCD press the 'New Document' icon in the top left of the toolbar, press
'File' -> 'New' or select 'Control Panel' under the 'Acquire' menu.
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Standalone CCD Mode - Set Up, Calibrate, Scan a Blank
This mode allows users to set up the CCD Array detector for the acquisition of whole UV/VIS
absorbance spectra both as single scans and multi-scans in a kinetic mode.

The screen shot below shows the CCD Array Control Panel which provides the access to the set
up and acquisition routines necessary for the effective use of the CCD array detector with the
stopped-flow system.

Press the 'Spectrometer' button under Set Up to enter the manual setup mode:
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This will display the 'Array Setup Wizard' dialogue:

Now the user can make adjustments to the integration time, optical alignment and depending on
the light source, the light intensity and hence signal level. Note that this signal must not saturate
the full scale.

In addition to setting the integration time, the user can select the region of interest. The live
display shows the full spectrum from the CCD including areas that may not be of interest. The
'Start wavelength' and 'End wavelength' panel will set the yellow vertical lines on the display
highlighting the current region of interest. Anything outside of this region will be cropped and
can be disregarded. Please ensure the signal IS NOT saturated within the region of interest,
otherwise this can affect subsequent scans and shots by giving invalid data in saturated regions.

ADVANCED: Areas outside of the region of interest can be saturated (full signal beyond the scale
of the device). This allows the optics to be optimised for the region of interest. This can be of
particular help in the UV region.
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Technical Help: the integration time is the time between resets on the array - it sets
the maximum scan rate such that the minimum integration time allows the
maximum scan rate. This also relates to the availability of light and noise
performance - with a bright, intense source (eg. the xenon lamp) more photons
are available and thus the shortest integration times should be usable.

The 'Hardware Type and Settings' button provides access to the following configuration
options:

If any of these options are set, the settings will be applied to every scan or shot automatically.
Please note that post-acquisition smoothing, binning and averaging is also available via the
'Tools'menu. When the options have been chosen, press 'Done' to return to step 1 of the setup
wizard.
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After the optics have been optimised and an appropriate integration time select, press 'Next' to
proceed to the 0% and 100% reference scans procedure on step 2 of the wizard.

Using 'Next' the system will acquire the 0% Transmission and 100% Transmission data and thus
the scan blank.

If a shutter cable assembly is available with a supported light source, or the optics are part of an
integrated system supplied by TgK Scientific Ltd then the 0% and 100% acquisitions will be
automated. For all other hardware Kinetic Studio will prompt to close the light off for a 0% scan
reference and then re-open the light source for the 100% reference

Kinetic Studio will run some initialisation routines on the CCD after it has acquired the 0% and
100% references and will display a please wait notice.

Once the scan blank and initialisation process has completed the software will present a 'Finish'
button and finalise the setup process.
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CCD Hardware Options
To access hardware options, press the 'Hardware' button on the control panel. This will display
the 'Hardware Configuration' panel as below:

Binning and Cropping

Kinetic Studio allows the user to automatically crop diode array data or 'bin' pixels.

Pressing the 'Binning and Cropping' button will show the following setup screen:



CCD Array

©TgKScientific Limited, 2018 79

Binning allows the user to potentially increase signal to noise by combining adjacent pixels on the
CCD Array unit. For example, this means a 1024 pixel diode array with binning set to 2 will
appear as a 512 pixel diode array. Options here include 'Average' (bin the pixels and use the
average of the binned pixels), 'Cumulative' (add the value of the binned pixels together) and
'Adaptive' (using the number of pixels to accumulate as a maximum threshold, the software
increases or decreases the amount of averaging depending on the light throughput. This should
yield improved signal to noise in regions that have less light or more absorbance).

Enabling the cropping option causes scans to be automatically 'trimmed' to the region of interest.
This is the area highlighted in green.

A manual, post-acquisition cropping facility is available via the 'Tools' -> 'Crop'menu item.

If the dataset has been rotated, the cropping edit boxes will reflect time rather than wavelength.

Trigger Modes

The trigger modes panel in the Hardware Configuration Window allows different criteria to be set
for data acquisition to start. These will normally be set by Kinetic Studio depending on the
shortcut used to launch it.

'Integrated System Trigger': Use when the CCD is part of a SF61-SX/DX system.

'Immediate Software Trigger': Use when there is no connected trigger functionality. Data
acquisition starts immediately after pressing 'Single Shot'. It is recommended to extend the run
time when using this mode to allow for manually activating the drive.

'External CCD Hardware Trigger': Use when the CCD has a connected external trigger
system.
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Slice
Kinetic data can be sliced at a particular wavelength. This enables the user to quickly extract 2D
data in terms of signal versus time at a specific wavelength.



CCD Array

©TgKScientific Limited, 2018 81

SVD Analysis
Kinetic Studio provides access to Singular Value Decomposition facilities in addition to various
other data processing functions and analysis tools.

Please ensure data is saved prior to using the SVD tool.

SVD is a powerful tool that can help analyse the complex stages and components in a dataset.
Additionally Kinetic Studio allows the data to be reconstructed from a reduced number of
eigenvectors facilitating the removal of unwanted components / noise.
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For more information on SVD, factor analysis and other related analytical techniques that may be
useful, please refer to the following book:

Factor Analysis in Chemistry

Edmund R. Malinowski
ISBN: 978-0-471-13479-4
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Spectrometer Mode
Kinetic Studio can be started in a dedicated Spectrometer Mode providing quick and easy access
to single and multiple scans with averaging.

A dedicted control panel is added to the right-hand side of the screen putting all of the required
functions for using the CCD right in front of the user.

Spectrometer mode when used in conjunction with a cuvette holder and suitable light source
gives the convenience and flexibility of a modular bench-top spectrometer.

Additional functions and features are being added to spectrometer mode with new versions of
Kinetic Studio. If there are specific features or suggestions that you would like to be considered
for inclusion, please contact TgK Scientific Ltd.
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How to use the Sequence Setup
The features found in this dialogue are used to execute shots (for stopped-flow) and jumps (for
temperature-jump), and acquire data using user tailored routines enabling experiments to be run
in a semi-automated fashion often aiding productivity and enhancing reproducibility.  Upon
exiting this dialogue, the acquisition control panel “Shot button” will display 'Acquire Series'…
clicking this will commence the execution of the defined sequence without any further user
intervention (except to refill reagents if necessary).

Average sequence
The tab labelled “Averages” accesses a sequence where the user can set up a sequence of shots at
a defined wavelength over a defined run time – The user enters the desired number of shots to be
executed and these are subsequently presented with their average in a combined data set.
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Time Delay Sequence
A delay period can be added to a sequence to allow for temperature equilibriation between shots.
This is particularly pertinent to T-Jump operation where multiple jumps are necessarily averaged
and to T-pod operation where the mixing cell is kept at a different temperature to the syringes.
The difference in this mode is that a 'delay period' can be defined within the sequence dialogue.
This allows the sample to cool sufficiently before the next shot in the sequence. If the user should
want to execute the shot early (ie. before the delay period has expired), the user can cancel this
'delay period', after which the shot will fire.

In addition to the cooling period, the T-Jump will wait for a number of seconds prior to the shot
so that the capacitor bank has time to charge and prepare for the shot (this can be changed under
the 'Tools'...'Options'...'User'...'TJump'...'TJump Recharge Time' option).

The cooling period is set to 60 seconds by default. This can be enabled using the check box in the
sequence dialogue and is available for editing:

Wavelength Sequence
The tab labelled “Wavelength” allows the automated collection of shots over a wavelength range
collecting a shot at each discrete wavelength and then making the sequence of shots into a
pseudo 3D block where spectra-kinetic data can be assembled from the multiple shots.

Age Time DX Sequence
The tab labelled “Age Time” is applicable to double mixing instruments where the user can run a
sequence of DX shots where the age time increments as defined by the user in the dialogue.  The
resulting data will be a series of shots where the age time becomes the third dimension.

In the Event a Sequence Stalls
While it is best to organise a sequence of shots that only consume reagent within the limits of the
drive syringe, often it is inevitable that a sequence of shots will run out of reagents.  Under such
circumstances two options are available:
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When more reagent is available: The sequence can be halted by clicking 'Abort' within the
Acquisition in Progress dialogue.  The user is confronted by options to Continue or Cancel.  This
allows for refilling and then using the Continue command, the sequence will continue.

When more reagent is not available: In this case the Cancel command will abandon any
further attempt to complete the sequence but keep the data collected so far.
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Double Mixing Stopped-Flow
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Enabling Double Mixing Modes
The double mixing (DX) (sometimes called, sequential mixing) capability of the SF-61DX2
instruments is controlled from Kinetic Studio – the following provides a guide to how to run a DX
experiment.

It should be understood that SF-61DX2 units can be configured to operate in either single mixing
mode or double mixing mode at the click of a (mouse) button.  The sample handling unit features
a convenient light on the front panel to indicate which mode it is currently set to.

It is important to adjust the waste stopping block to the correct volume depending on whether
single or double mixing mode is enabled.  This takes into account the syringe volumes within the
instrument and the volume required for the first and second stages of the sample delivery.

The user is urged to study the appropriate sections of the hardware manual to familiarise
themselves with the system plumbing and the general arrangement of the sample handling unit –
failure to do this will likely limit the users full understanding of the DX operation.

Upon start up and initialisation of the system, the default condition of single mixing mode (SX) is
selected.  The user need only continue to read this section if double mixing mode (DX) is
required.

On the control panel, please press the 'Hardware' button to access the sample handling unit
configuration panel.
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This will display the panel as pictured here. 

The first panel displayed is the 'Electronics' page. 

Click on the 'Sample Handling Unit' tab.

Enabling or disabling double mixing mode is done by
adding or removing the check mark in the 'Double mixing
mode' box in the bottom right corner.

As soon as the check mark is added or removed the
command is sent to the instrument.  The indicator on the
front panel of the SHU will immediately change to reflect
the current mode of operation.

Note:  For double-mixing experiments the stop block has to be set to 240 µl stopping volume.  To
move the stop block, loosen the three socket screws (at the rear of the Sample Handling Unit) and
with the WASTE/STOP valve set to WASTE, pull down the stop syringe piston until it reaches 240
ml.  Move the stop block with the piston and tighten the three screws. (Refer to the hardware
manual).

Ensure the stepper motor drives are reset – this can be achieved by clicking the relevant reset
button in the 'Sample Handling Unit' tab in the Hardware Configuration dialog.

Next, the Acquisition Control Panel is used in a similar manner to single mixing mode and the
acquisition run time and wavelength is set (it is assumed that optical and data set up protocols
have been gone through at this stage).
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Note that in DX mode the Age Time control is enabled – this is where the user can set a target age
time and thus effect the pre-mixed sample incubation time between the two drives.

It is strongly advised that users become familiar with the operation in this mode and consider
starting with some test runs with water or buffer.  An age time should be set – and it is
recommended that a modest value such as the default 1 second is used initially.  Click the Single
Shot button and the user should hear (albeit faintly) the whirring sound of the stepper motor
driven blocks moving into position as a precursor to doing the shot.  With the block sets, the
Stop/Waste valve will toggle and the stop syringe empty … soon after Drive 1 will fire and part fill
the stop syringe, then after the time delay, Drive 2 will complete the action of the sample delivery
and thus effect the stop flow shot and data acquisition.

How to Reload the Drive Syringes During a Shot
This action is mostly required during a multi-shot sequence where more shots are programmed
than can be obtained from the drive syringes.  This happens because there is insufficient solution
in the drive syringes to fill the stop syringe, the data acquisition does not get triggered and the air
drive does not deactivate.

Depending on which mixing mode is used, follow the relevant steps...

How to Reload the Drive Syringes During a Single Mixing Shot
The software will be waiting for a trigger signal but if there was insufficient volume remaining in
the syringe, the trigger mark will never be reached.

To reload the syringe and execute the shot again, the first step is to 'Abort' the current
operation.
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If the operation was a single shot, Kinetic Studio will return automatically to the control panel.

If the operation was part of a series, Kinetic Studio will ask what should be done next.

At this point, the syringe can be reloaded.  After the syringe has been refilled, a repeat of the last
shot can be initiated by pressing the 'OK' button.  Alternatively the 'Cancel' button can be
pressed to abort the current programmed sequence.

How to Reload the Drive Syringes During a Double Mixing Shot
The software intelligently tracks where the stepper motors are during a shot sequence.  If it
detects there is insufficient volume, it will inform the user and prompt for what should be done
next.

Do NOT act on the message below until the drive syringes have been reloaded.

Once the drive syringes are ready, press 'OK'.

Kinetic Studio will then prompt to click 'OK' to continue and repeat the last shot, or 'Cancel' to
abort the shot sequence.
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Advanced Drive Positioning
Kinetic Studio allows accurate and customisable drive positioning for both drives 1 and 2.

To access this facility, please go to the 'Hardware Configuration' panel by pressing the
'Hardware' button within the control panel.

Within the 'Hardware Configuration' panel, select the Sample Handling Unit tab.

Press the 'Advanced Drive Positioning' button.

The software will prompt you to make valves A and B are in the fill position before making any
changes.
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The green arrow buttons on the left provide fine and larger more granular adjustment of Drive 1.

'Reset' will reset Drive 1 only.

The 'Drive 1 Position Seek' section allows the drive to be quickly moved to some general
positions. The scale can be approximated to the full range of the drive. For example, if the middle
position is selected and the 'Go' button pressed, the drive will locate to the midpoint.

The 'Custom Drive 1 Movement' enables the user to enter custom stepper movements for drive 1.
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qPod Mode
In this mode of operation the qPod device is fitted as described in the hardware manual providing
a configuration that enables the chemical quenching of reaction volumes using the double mixing
mode of operation. However, without the need to acquire data from an optical signal, the process
is merely one of running a series of time delayed, quenched samples, and collecting them. So in
this mode, Kinetic Studio does not activate any control of optical devices, it merely enables
control of sample delivery.

The qPod mode of Kinetic Studio provides a simplified control dialogue for the user to set up and
command time delay shots and record each shot with its associated instrument parameters in a
convenient spreadsheet format. Thus a data log of acquired shots is recorded. When the qPod
mode initialised, the following screen greets the user:
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The major area of this is the spreadsheet which records line by line the sequence of shots, the
right hand portion is the sample handling unit control panel:

This dialogue provides the features necessary for setting a time delay, commanding a shot and
asigning shot names:

'Single Shot' is the control to activate a double mixing shot (the normal mode of operation for
quenching experiments).

'SX Priming Shot' is the control to shoot just C and D syringes (and is used to provide a
priming shot to fill or flush the flow circuit).

'Abort' enables the user to abort a single shot.

The 'Age Time' entry box is where the user sets the desired age time. this can be entered
numerically from the keyboard or using the up/down arrows.

The 'Name' entry box allows the user to set the name for each shot - this will be retained during
a session until edited by the user and will appear under "Name" in the report spreadsheet.

'Drive 1 Up' and 'Drive 2 Up' are controls that allow the user to move the drive up (via the
stepper motors) in an incremental fashion and thus facilitate partial filling of the drive syringes.
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'Reset Drives' is the control that allows the user to reset the two drives resetting them to the
fully retracted, (start) position.

'Hardware' opens up another dialogue that provides the user with options to reset drive syringe
sizes, shot volumes and other instrument parameters. Generally the default values should be left
set unless a special syringe configuration is used.
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Executing a qPod Shot
The operation of the qPod should be studied in the appropriate section of the hardware manual.
The operation of Kinetic Studio in this mode is very straightforward and the following screen shot
shows the result of running a shot:

Here the shot has been recorded by the first line entry with age time and other parameters
acquired during acquisition. Note that a substantial section has been allocated for the user to
enter comments - it is anticipated that this will provide the basis for identifying samples taken
from the quench-flow experiment that will be subject to other analytical techniques.



- This page has intentionally been left blank -

©TgKScientific Limited, 2018 100



T-Jump Mode

©TgKScientific Limited, 2018 101

T-Jump Mode



T-Jump Mode

©TgKScientific Limited, 2018 102

How to Setup for an Experiment in T-Jump Mode
Overview
The Control panel can be displayed by selecting the new document icon on the shortcut bar or by
selecting 'Control Panel' under the 'Acquire'menu.

The configuration of the software will depend on the type of experiment. 

Initial Setup
Setting the Data Type and Dataset Parameters
The first step in setting up Kinetic Studio for an experiment is to configure the main channel and
setting the data type.

For T-Jump, the data type options are limited to, and set under 'Data':

The relevant 'Data Type' options are:

l Transmission
l Fluorescence
l Light Scatter

And are only applicable to Channel 1(Main). The 'Modifiers' available are:

l Unknown
l None
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Each channel can be enabled by
checking or unchecking the 'Enabled'
checkbox.

The number of data points can be
increased or decreased resulting in
more or less detailed datasets.  The
default is 512 but for T-Jump, it is
often necessary to use fewer (eg 256).

Oversampling helps to increase the
quality of data and resolution.  It has
the ability to increase signal to noise
by collecting number of data points
and averaging them together.  By
default this is set at 48 but may be
reduced to access shorter, faster time
scales. Indeed, for T-Jump
acquisitions speed tends to be priority
so often the oversamples may be set
to 1.

Pretrigger can be configured as a
percentage of the run time prescribed.
It is particularly useful with T-jump to
ensure the whole jump is being
monitored.

Data Trigger Offset
The data trigger offset, found in the main 'Control Panel' > 'Options', should be set to 5 x 10-6
seconds. This is to allow for the time for the electronics to initiate.

Time Constants
The time constant, tc , is set in 'Control Panel' > 'Hardware' is an electronic filter applied to
the signal. For a detailed description see the hardware manual.

The time constant must be set so as to reduce the noise in the system while not affecting the
signal amplitude. For the fastest reactions the time constant should be set to 1 x10-6 seconds.

Optimising and maximising the signal to noise ratio is achieved by the appropriate use of the time
constant, over-sampling data points and averaging a sequence of (multiple) shots.
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Recharge Time
The recharge time is found in 'Tools'…'Options'…’TJump Recharge Time’. This sets the time
taken to charge up the capacitor banks and is set to 10 seconds by default.
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Setting the References / Spectrometer Manual Setup
This section guides the user through setting up the system optically and enabling data collection.

Press the 'Spectrometer' button to enter the photomultiplier setup routine.  This will display the
'Photomultiplier Setup Wizard':

Select the 'Manual setup and references' to begin a manual setup:

The manual setup panel will be visible along with the live display.  This allows the user to set the
wavelength and read signals for both 0% and 100% for the main channel. Note: Aux and Ref
Channels are mute in T-Jump Mode.



T-Jump Mode

©TgKScientific Limited, 2018 106

When used for absorbance measurements, 100% (maximum incident light) and 0% (dark
condition) transmission reference levels are required to be recorded for a single wavelength.
When used for fluorescence measurements, this set wavelength is the excitation wavelength
and although reference levels can be acquired, normally the Live Display is used simply to
maximise the fluorescence signal by optimising the optics and adjusting the PM Volts at this
wavelength.

Simply exiting the setup dialogue by pressing 'Next' and 'Finish' enables data collection at the
set wavelength.  Often fluorescence measurements are made without any set references.

Manual Setup for Absorbance
Specific details for a manual setup for absorbance:

1. Ensure the flow circuit and in particular the observation cell is flushed and as such contains
water or buffer solution.

2. Optimise the optics for maximum signal.
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3. Increase the PM voltage until the signal trace approaches 80% span.

4. Collect the 0% reference data by either pressing the button(s) next to each channel in the
0% column or enter them numerically, or press the 'Read 0%' link to collect for both
channels. Remember to shutter the light manually for 0% reference levels.

5. Click Read all to read the 0% and 100% levels and simply exit the setup dialogue by
pressing 'Next' and then 'Finish' to enable data collection.

Manual Setup for Fluorescence
The user will need to have prior knowledge of the excitation & emission wavelengths for the
fluorophore to set the monochromator at the correct excitation wavelength and to put the correct
emission filter in the optical coupling.

1. Ensure that the fluorescence lens and the appropriate emission filter are fitted in the path
of the photomultiplier.

2. Introduce the sample solution to the cell via one of the luer fittings found in the cell block
assembly.

3. Open the shutter and increase the (Main Channel) PM volts until the signal level responds.

4. Optimise the optics for maximum signal. The user should note a few points here: the
fluorescence may decrease due to photo bleaching – replenishing the cell contents
periodically will offset this problem, however, the timescale of the bleaching process is
likely to be a relatively slow process. Secondly, the excitation wavelength can be adjusted
to find maximum response, especially when using line sources such as mercury/xenon
lamps.

5. Increase the PM Volts to set the signal level close to an 80% span. This should
accommodate for decreasing or increasing signal levels.

6. Click Read all to read the 0% and 100% levels and simply exit the setup dialogue by
pressing 'Next' and then 'Finish' to enable data collection.
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How to perform a Scan Blank (Absorbance)
This mode allows users to set up for absorbance measurements to be taken over a range of
wavelengths and are thus able to acquire kinetic data at different wavelengths and/or acquire
single scans to characterise reagent spectral information.

When the system is configured for absorbance measurements, before acquiring new data it is first
necessary to align and focus the optics, set the correct photomultiplier voltage and scan a blank. 
Scanning a blank involves the monochromator scanning a wavelength span acquiring 100%
(maximum incident light) and 0% (dark condition) transmission reference levels.

Before performing this operation, ensure that the optical cell contains pure water or a buffer
solution.

To perform an auto-setup scan blank, perform the following steps:

Press the 'Spectrometer' button to enter the manual setup mode. 
This will display the 'Photomultiplier Setup Wizard'.

Next the dialogue will offer choice of a scanned set up and a manual set up.  The former invokes
the use of a scanned blank over a user selected wavelength range, the latter provides for users
content to set up at just a single wavelength.

A scanned blank is appropriate for absorption studies only; the manual set up can be used for
absorption and fluorescence.
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Here, we will begin with selecting the 'Set up and scan a blank' to begin the wizard driven
setup. The 'Lamp Settings' panel enables the user to select the lamp currently within the
system.  This in turn automatically fills the wizard with typical wavelength ranges, optimisation
and alignment wavelengths for the blank.

The first step is to select the lamp currently fitted to the system.

If the typical values for the wavelength range are not suitable or require adjustment, please edit
the desired start and end wavelength spans for the lamp.
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To ensure optimal distribution of the signal over the scan blank wavelength span, the user should
optimise the optics at one wavelength, and then maximise the PM volts at another wavelength. 
This is especially critical when using a wide wavelength span. 

To restore the default values for a particular lamp use the 'Set Defaults' link.

It is often convenient to set the lamp optimisation wavelength to suit the wavelength range where
absorbance changes are to be studied. 

The edit field labelled 'PM Volts' is the wavelength where the PM volts are maximised; this
ensures that the maximum signal span is achieved under normal circumstances.  With the Xenon
and QTH lamps, this is set at 480 nm as this is where the system exhibits a maximum signal.

Once the lamp and wavelength ranges have been set, please press the 'Next' button to proceed
with the first stage of optimisation.

As the 'Optical Alignment' page appears the monochromator will move to the specified ‘Optical
Alignment’ wavelength as specified on the previous page of the wizard.

To perform the optimisation, open the PM-61s photomultiplier shutters and adjust the PM Volts
for the main channel (green trace), increasing the signal at the Live Display to about 50%. This is
simply used as a mid-point to allow for positive and negative shifts when the optics are adjusted.

Follow the procedure for optimising the optical components as described in the Section 3 of the
TJ-64 User Manual. In brief, adjust the lamp position and its alignment. It may be necessary to
adjust the PM volts for the particular channel should the signal saturate.

After finishing the optimisations, return the signal level back to 50% on the Live Display, this is
simply used as a relative indication of signal level when moving to the next wavelength.
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As the 'Photomultiplier Voltage Adjustment' page appears, the monochromator will move
to the adjustment wavelength as specified previously. 

Increase the PM Volts for the relevant channels, so setting the signal level(s) to about 80% full
scale.  You must ensure that the signal does not saturate, ie. go above 100% full scale.

As a quick check it is worthwhile clicking the ' Back' button to ensure the signals are not
saturated at the previous wavelength where the optical optimisation was performed.  If they are
saturated, go to the next page and lower the PM Volts for the relevant channels.

This concludes the optimisation process.  Clicking the 'Next' button will present the 'Scan
Blank' page.
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Scanning the Blank

The scan blank process is fully automated. 

The process will begin with a full monochromator re-calibration.

The scan blank process consists of scanning a baseline with no light (0%) and with the filter
wheel open (100%). Whilst traversing through the wavelength range, the system will
automatically insert appropriate filters.

After both the 0% and 100% scans have completed, the system will acquire static baseline
references and present the 'Set Up Completed' panel.

The system is now ready for use.
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An example of a scan blank collected with the xenon lamp:

T-Jump Shot Sequence
A full T-Jump system is able to perform automated shot sequences.

To learn how to use this facility, please refer to Time Delay Sequence on page 86
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Conductivity Description
The conductivity cell is a cylindrical cavity in a teflon block, 3mm long and 3mm diameter.

The ends are closed by platinum electrodes. The nominal cell volume is 21ul, and the nominal cell
constant 4.24cm-1. Reagents are mixed in a T mixer just upstream of the observed volume.

The conductivity meter has the following ranges:

Unit: Siemens (S)
Range 1 0 to 0.5
Range 2 0 to 0.05
Range 3 0 to 0.005
Range 4 0 to 0.0005
Range 5 0 to 0.00005
Range 6 0 to 0.000005

The full scale voltage for each of these is 10V although Range 1 may be limited to 250000uS at
5V - linearity above this level should not be assumed without calibration.  Furthermore, operation
at cell conductivities above 250000uS should not be attempted at ambient temperatures above 30
degrees C in order to avoid excessive dissipation from the amplifier.

The bias control enables the user to "backoff" up to 10V of signal; this means that signals up to
the full scale output of 10V can be offset so that any signal change can be digitised within a 0 - 5V
analogue channel input range.

How to Setup for an Experiment in Conductivity Mode
Overview
The Control panel can be displayed by selecting the new document icon on the shortcut bar or by
selecting 'Control Panel' under the 'Acquire'menu.

The configuration of Kinetic Studio will depend on the type of experiment and whether the
software is controlling a Conductivity option for the KinetAsyst Scientific Stopped-Flow
instrument or whether it's acting as a data acquisition suite for the dedicated Conductivity
apparatus.

For installation and configuration with the KinetAsyst Stopped-flow system refer to the
SF-61DX2/SX2 User Manual, OPT-642 - Conductivity Detection.

For the dedicated Conductivity apparatus, refer to the CSF-21 User Manual.
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Initial Setup
Ensure that the Conductivity meter is switched on for at least 30 minutes to ensure it has
stabilised.

At the Conductivity Control Panel, select 'Set Conductivity Parameters', a dialog
incorporating a live display will appear.

Use the live display to set the RANGE and METER OFFSET at the Conductivity meter.  Make sure
that solution is pushed through to the mixing cell and start with the RANGE set at 1 and the
OFFSET set at 0. Increment the RANGE and observe the signal, do so until the signal maximises.
Note that incrementing to the next range causes the signal to fall again and become very noisy -
this is because the amplifier has been driven into saturation.

Having adjusted the signal with the selection of the optimal range and meter offset, record these
settings by selecting the corresponding 'Range' check and enter the applied 'Meter Offset' ,
this is necessary to ensure subsequently acquired data is converted correctly.
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Setting the Dataset Parameters

The first step in setting up Kinetic Studio for an experiment is to configure the number of data
points required, oversampling and pretrigger.

The number of data points relates to the final dataset and graph.  This can be adjusted depending
on the experimental requirements and trace detail.  The typical number of data points used in an
experiment is 512.

Oversampling can be used to improve signal to noise and hence the quality of data.  For every
data point, oversampling corresponds to the number of additional samples that are averaged
together. 

For example, the screenshot above shows 512 data points have been specified with 48
oversamples.  This means the data acquisition device will acquire 512 x 48 samples (24576
samples in total).  Every data point is an average of 48 samples.  The software will automatically
perform the averaging after the experiment has completed.

Pretrigger can be used to acquire data just prior to the trigger point.  The amount of pretrigger is
specified as a percentage of the run time.

Setting the Run Time

The experimental run time can be manually entered by editing the 'Run Time' numeric box or
alternatively a series of standard run times can be applied by clicking the small up and down
arrows next to the 'Run Time' box.

For shots requiring a log acquisition and hence being displayed with a logarithmic x-axis, the
'Logarithmic timebase' option can be enabled.  The standard log timebase applied is 10 log
cycles with 64 points per log cycle.  Kinetic Studio intelligently uses the additional samples
acquired for logarithmic processing to apply data averaging improving the signal to noise.

Should the experiment require it, a custom log mode facility can be accessed by pressing the link
'Logarithmic timebase'.  This will display a log parameter editing utility as shown.
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If the Conductivity device being used is an option for the Stopped-Flow system, the ability to edit
the 'Age-Time' will be made available. 

Specifying a file name

Within the 'Data Set File Name' area to the bottom left of the control panel, enter a file name
that corresponds to the experiment being performed.  If required (generally recommended),
create a folder for the group of experiments being performed and save all related data into that
folder.

Kinetic Studio provides a convenient facility to specify a working folder.

Please consult the 'How to Change the Current Working Folder' subsection within the
'Dataset File Management' section.

Adding Notes to a Dataset

Clicking the ‘Set Notes’ link in the file name group will display a small notes editor.

The notes editor provides a facility to save experimental
information or comments with a dataset.  These notes will be
applied to every shot.

Notes for a given dataset can be displayed and edited by selecting the 'Notes'menu item under
the 'Graph'menu as shown below.
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Adjusting Hardware Options and Signal Conditioning

Some hardware options are only available for the
Stopped-Flow Conductivity option.

When the full KinetAsyst Stopped-Flow instrument
is present, 'Hardware Configuration dialogs'
will be available.

Syringe and drive volumes can be configured. 

Single or double mixing modes can be enabled
depending on the hardware available.
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The control panel provides convenient access to a live display / monitor.  This facility enables a
live data acquisition window displaying the current voltage levels per channel.

The advanced settings panel provides the following options: 

Generally it should not be necessary to use the Advanced monitor settings.
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How to Acquire a Single Conductivity Shot
Having configured the conductivity meter and set the appropriate acquisition parameters at the
control panel, next

Important: Ensure the drive syringe plungers are in contact with the push plate. Failure to do so
may result in damage to the flow circuit should the drive be actuated.

1. If the syringes are air driven, ensure the drive air pressure is set correctly.

2. Set the appropriate stopping volume.

3. Ensure the reactants are loaded into the drive syringes.

4. Set the Drive/Fill valves are set to the Drive position.

5. Where required and if it hasn't been done already, set the appropriate number of
'Data points', 'Oversamples', etc. for the experiment.

6. Set the data file name and number under 'File Name' and 'File Number' on the Control
Panel.

7. Prescribe the desired run time for the acquisition, checking the option for Logarithmic time
base if required.

8. When you are satisfied with your settings, click the [Single Shot] button on the Acquire
Control Panel to arm the data acquisition.

The acquisition progress box will appear.

Where the Conductivity option is installed and being used with the full KinetAsyst Stopped-
flow system, the instrument control features will automate the entire shot sequence.

For dedicated Conductivity apparatus, the acquisition progress box will include a message
'Awaiting Trigger' .   Where upon the user should initiate a shot by activating the air
drive.

9. Where the stop syringe hits the stop block data acquisition starts.
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How to Acquire a Conductivity Shot Series

Kinetic Studio provides a convenient option for collecting a series of data shots and averaging
them.

To enable the option ensure there is a check mark in the 'Series Average' option in the 'Shot
Sequence' group box. When activated the shot button will change to [Series].

The number of shots in the series can be changed by either manually entering a numeric value, or
by using the small up and down arrows associated with the 'Number of shots' edit field.

Note: The dedicated Conductivity apparatus only holds a limited amount of sample within the
thermostated block. Check the 'Enable shot delay' box and use the 'Delay between shots'
field to set an equilibration time.

Important: Ensure the drive syringe plungers are in contact with the push plate. Failure to do so
may result in damage to the flow circuit should the drive be actuated.

1. If the syringes are air driven, ensure the drive air pressure is set correctly.

2. Set the appropriate stopping volume.

3. Ensure the reactants are loaded into the drive syringes.

4. Set the Drive/Fill valves are set to the Drive position.
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5. When you are satisfied with your settings, click the [Series] button on the Acquire
Control Panel to arm the data acquisition.

The acquisition progress box will appear

Where the Conductivity option is installed and being used with the full KinetAsyst Stopped-
flow system, the instrument control features will automate the entire shot sequence.

For dedicated Conductivity apparatus, the acquisition progress box will include a message
'Awaiting Trigger' .   Where upon the user should initiate a shot by activating the air
drive.

6. Data acquisition is initiated when the stop syringe hits the stop block.

7. On completion of the acquisition process, data appears in the graph window and the
sequence is repeated.  The acquisition progress bar will appear for each shot.  This
sequence will continue to be repeated for the programmed number of shots.

If during the shot series the drive syringes reach their full span, the drive syringes will
have run out of solution.  This results in the current shot not completing and hence the
acquisition will not have been initiated.  Cancel the current shot and reload the drive
syringes.

For the Conductivity option being used with the full KinetAsyst Stopped-flow system, the
software will either wait for the shot to be cancelled or a prompt will appear depending on
the mixing mode, where upon the drive syringes can be re-loaded and the shot series
continued when ready.  During the process, there is also the option to abort the shot series
altogether.

8. On completion of the shot series, the newly displayed dataset will show the overlaid shot
data and include the determined average
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Data Manipulation
Introduction
Data manipulation functions can be found in the Tools menu.

The functions available will depend on the type of dataset.

For convenience conversion operations can be quickly accessed via the 'Convert' sub menu.

Several functions can also be accessed via the thumbnail right-click menu.

Rotating a Dataset
Three dimensional datasets can be conveniently rotated using the 'Rotate' option shown in the
main 'Tools'menu above or by using the keyboard shortcut 'Ctrl'+'R'.

Additionally a new context menu item has been added to the thumbnail navigator allowing single
or multiple datasets to be rotated.
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Extracting Traces from Datasets
There are three ways to extract traces from a dataset.

The first method accessible via the 'Tools' ... 'Extract'menu item (or by pressing the
'Ctrl' + 'E' shortcut key) provides a list of all traces within the currently displayed dataset. Each
trace can be selected or deselected which in turn determines what is copied into a new dataset.

The trace selection dialog will be displayed. This allows the selection of which traces should be
extracted.
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The traces can be extracted into a single new dataset, or each trace can be placed into a new
dataset.
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Dataset Calculator
Kinetic Studio provides a convenient dataset calculator for data manipulations. This allows
mathematical expressions to be entered and applied to data on all applicable axes.

The maths engine uses a script processor allowing complex calculations to be entered if required.
These scripts may then be saved and recalled at a later date.

The left hand panel within the Dataset Calculator provides a list of available datasets. Each dataset
can be expanded to show the contained traces.

Calculations can be applied per dataset or per trace.

Previewing a Dataset
To preview a graph of the dataset, select either a dataset or trace within the left-hand dataset list.
As soon as something is selected, a 'Before' preview of the dataset or trace will appear on the
right hand side.
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Entering Datasets or Traces into the Calculator
Traces or datasets can be entered into the calculator in two different ways.

The first method is to double mouse-click a dataset or trace. The calculator will enter the details
into the edit window. A dataset entry consists of the dataset identifier DS# so in the above
example, DS1 would represent the whole dataset.

If a specific trace within the dataset is to be manipulated, this will be displayed as DS1.# where
DS1 represents dataset with ID 1 and # is the trace number. For example, DS1.1 means dataset
1, trace 1. DS2.5 would represent dataset 2, trace 5.

If a dataset is entered with a trace number of 0, this also represents the whole dataset.

Further examples,

DS1 represents dataset 1, all traces.

DS1.0 represents dataset 1, all traces.
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DS1.4 represents dataset 1, trace 4.

The second method of entry is to type the dataset details into the editor using the keyboard.

After entering the dataset or trace, the trace can be manipulated by pressing one of the function
buttons or by entering an equation. Example,

After entering a calculation, a preview of the resulting dataset will be generated within the 'After'
preview panel.

When ready, select the option to either Append the result into an existing dataset or 'Create New'
dataset. Then press [Execute] to perform the calculations.
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Calculator Functions
Below is a summary of the various calculator functions and how to use them.

Copying a Dataset
The calculator offers a fast and convenient way of copying a dataset and then working on the
copy. To do this simply enter the dataset into the calculator and press [Execute]. A copy of the
dataset will then be generated.

Extracting a Trace
The dataset provides a quick facility to extract a trace into a new dataset. To do this simply enter
the dataset and trace details into the calculator. Example, DS1.2 will take a copy of trace 2 from
Dataset 1 and place it into a new dataset.

Convert a Dataset Type
Kinetic Studio provides convenient options to convert the data type.

For more information about absorption of light, concentration, extinction coefficients and their
relationship in Beer Lambert's law please see the reference manual.

The following conversions are available depending on the original data type and compatibility:

Convert to Absorbance
This allows the dataset to be converted to absorbance units.

Syntax: Absorbance(DS#)

- The signal type must be Transmission

Supported Ordinates:

- Raw
- Concentration
- Percentage
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Convert to Concentration
Convert to a concentration dataset using Beer's Law relationships.

Syntax: Concentration(DS#,ConcentractionFactor)

ConcentractionFactor is Absorbance / Molar Absorptivity

Supported Ordinates:

- Raw
- Absorbance
- Percentage

Convert to Conductivity
Convert raw conductivity data into processed conductivity datasets.

Syntax: Conductivity(DS#,Range,Factor)

Syntax: Conductivity(DS#,Range,Factor,Span,ZeroLevel)
The second syntax should only be used with 'Percentage' data, typical of KinetAsyst
conductivity data.

- Raw
- Percentage

Convert to Fluorescence
This function allows fluorescence polarisation datasets to

Syntax: Fluorescence(DS#)

The data must be fluorescence polarisation type.

Convert to Percentage
Convert a dataset from absorbance units to percentage.

Syntax: Percentage(DS#)

Supported Ordinates:

- Absorbance
- Concentration
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Combine
Combine multiple datasets or traces together into a new dataset.

Syntax: Combine(DS#.#,COMMA_DELIMITED_DATASETS)

Examples,

Combine(DS1,DS2,DS3)

Combine(DS1.2,DS2.7, DS4.2)

Rotate
Rotate a 3D dataset from wavelength to time or time to wavelength.

Syntax: Rotate(DS#.#)

Examples,

Rotate(DS3)

Rotate(DS3.0)

Normalise
This processes the y axes data so that the new range is factored by the new upper and lower
limits. The resulting data is re-scaled.

Syntax:Normalise(DS#.#,LOWER,UPPER)

Example,

Rotate(DS2.3,0,2)
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Smooth
The smooth function uses the Savitzky-Golay smoothing filter. This method performs polynomial
regression of degree k on a distribution of at least k+1 equally spaced data points. This approach
helps to preserve the features of a distribution.

Reference: The Savitzky-Golay smoothing filter was created by Abraham Savitzky and Marcel
Golay in 1964. "Smoothing and Differentiation of Data by Simplified Least Squares Procedures".
Analytical Chemistry 36 (8): 1627–1639.

Syntax: Smooth(DS#.#,SMOOTHINGPOINTS)

Example,

Smooth(DS3,13)

Power
This is otherwise known as exponentiation. It is written as an. Where a is the base and n the
exponent.

Syntax: Power(DS#.#,EXPONENT)

Example,

Power(DS8,2)

Derivative
This executes differentiation to a given 'ORDER' on a dataset or trace. Differentiation calculates
the rate of change of y with respect to x hence the derivative is a measure of how a function y
changes as its input x changes.

Syntax: Derivative(DS#.#,ORDER)

Example,

Derivative(DS12,3)
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Min
Find the minimum value in a given dataset or trace.

Syntax: Min(DS#.#)

Example,

Min(DS10)

Max
Find the maximum value in a given dataset or trace.

Syntax: Max(DS#.#)

Example,

Max(DS8)

Abs
Calculate the absolute value of floating point number.

Syntax: Abs(VALUE)

Example,

Abs(-2.65)

Log
Calculate the log of a number, dataset or trace to a given base.

Syntax: Log(DS#.#)

Syntax: Log(DS#.#,Base)

Syntax: Log(Number)

Syntax: Log(Number,Base)

Examples,

Log(DS20);

Log(4,10)
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Ln
Calculate the natural log of a number, dataset or trace.

Syntax: Ln(DS#.#)

Example,

Ln(18)
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Data Fitting
Introduction
The Analysis Control Panel provides easy access to switch to different traces (Select Trace) and to
fine tune the fitting parameters. A number of pre-defined models are included as standard and
are available via the 'Equation' drop-down box. In addition to the standard models, a user
definable equation editor is available.

Fitting a Dataset with a Standard Model
Kinetic Studio will ask which trace to fit.  This is done by
displaying a summary screen of all datasets in memory.

After selecting the trace, the Analysis Control Panel will be displayed.
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The Analysis Control Panel will attempt to calculate parameter estimates automatically for the user
based on the selected equation – these values can be adjusted if required, and they can be
'Fixed', i.e. the values are constrained by checking the 'Fixed' options.

The fitting equation can be changed by the 'Equation' drop down menu. All common models are
included as well as the Custom Model function to allow more exotic systems to be examined. See
Custom User Definable Equations on page 141 for more information.

The graph displays the chosen trace and an estimated fit.

Please note that the estimated fit may or may not appear to be accurate.  This will depend on the
model and the complexity of the fit.
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To perform a fit, please use the following guidelines:

1. Move the blue and green range lines on the graph to indicate the fitting area.  Numbers
can be manually entered into the blue and green start and end fields.

2. If a number of traces are going to be fitted, the option to 'Fix cursor positions for this
session' can be enabled.

3. Pick the appropriate model from the drop-down equation list.  In the example above, a
third order model has been selected.

4. The Analysis engine should attempt to estimate the fitting parameters and show an
estimated fit.  Depending on how good the estimate is the initial parameters can be
adjusted.

5. Press either the [Fit] or [Fit and Close] button to try analyse the data and execute the
fitting operation.

6. If the fitting process fails, the 'Options' dialog can be used to adjust the maximum
number of iterations and tolerance of the fit.

7. Once a successful fit has been completed Kinetic Studio will display the result and all
related statistics.
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8. The fit results may be printed using the built in reporting system using the 'Print' option in
the menu from right-clicking on the graph.
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Custom User Definable Equations
Kinetic Studio supports the ability to define custom fit models. This allows the user to define a
mathematical equation for fitting and to use non-linear least squares fitting to try and generate a
fit to the experimental data.

To access the custom equation library, the last entry in the built-in equations list is 'Custom Model'
as shown in the screenshot below:

This will display the Custom Model editor and library. A model that has been previously defined
can be selected, or a new model can be defined. The equation for the SuperOxide reaction is set
up as an example.

When generating a new equation model, Kinetic Studio will attempt to validate the model before
adding it into the library.



Data Fitting

©TgKScientific Limited, 2018 142

Entering a New Custom Model
When defining a custommodel, parameter names should use the following guidelines:

l A parameter name must begin with an alphabetic character a-z, upper or lower case.
l Parameters are case sensitive. E.g. param1 is not the same as Param1
l The independent variable must be t, T, x or X
l The dependent variable y must not appear in the equation
l An equation can contain up to 100 parameters

Please note that when entering parameters, certain reserved keywords, mathematical function
names and internal function names cannot be used.

* Currently, the typical rate constant variable 'k' cannot be used as a variable name. It is
recommended that R is used in its place.

Example parameters:

l A
l MyParam
l MyVar1
l R
l R1
l Rb

Internal Constants:

pi = 3.14159...
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Supported Mathematical Operations:

Mathematical Function Operator Usage
Power ^ num1^num2
Multiplication * num1*num2
Division / num1/num2
Integer Division \ num1\num2
Modulus mod num1 mod num2
Addition + num1+num2
Subtraction - num1-num2
Negation - -num1
Parenthesis ( (num1)
Parenthesis ) (num1)

Supported General Functions

Function Usage Description
abs abs(number) Absolute Value
exp exp(number) Exponential
fix fix(number) Similar to int
int int(number) Integer
log log(number) Natural log
ln ln(number) Natural log
log10 log10(number) Log base 10
rnd rnd(number) Random Number
sgn sng(number) Sign of a number
sqr sqr(number) Square Root
floor floor(number) Integer below number
ceil ceil(number) Integer above number
max max(num1,num2) Maximum of num1 or num2
min min(num1,num2) Minimum of num1 or num2
mag mag(num1,num2) Vector magnitude of num1 and num2
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Supported Trigonometric Functions:

Function Usage Description
cos cos(number) Cosine
sin sin(number) Sine
tan tan(number) Tangent
arcsin arcsin(number) Inverse Sine
arccos arccos(number) Inverse Cosine
arctan arctan(number) Inverse Tangent
sec sec(number) Secant
cosec cosec(number) Cosecant
cotan cotan(number) Cotangent
arcsec arcsec(number) Inverse Secant
arccosec arccosec Inverse Cosecant
arccotan arccotan Inverse Cotangent
hsin hsin Hyperbolic Sine
hcos hcos Hyperbolic Cosine
htan htan Hyperbolic Tangent
hsec hsec Hyperbolic Secant
hcosec hcosec Hyperbolic Cosecant
hcotan hcotan Hyperbolic Cotangent
harcsin harcsin Inverse Hyperbolic Sine
harccos harccos Inverse Hyperbolic Cosine
harctan harctan Inverse Hyperbolic Tangent
harcsec harcsec Inverse Hyperbolic Secant
harccosec harccosec Inverse Hyperbolic Cosecant
harccotan harccotan Inverse Hyperbolic Cotangent

Helper Functions:

rtod rtod(radians) Radians to Degrees
dtor dtor(degrees) Degrees to Radians

Example Equation:

((A * R1 * exp(-R1 * X)) / (R1 + A * R2 * ( 1 - exp(-R1 * X))))

In this model, X has been used as the independent variable. As X is representing time, it may be
more descriptive to use t for time:

((A * R1 * exp(-R1 * t)) / (R1 + A * R2 * ( 1 - exp(-R1 * t))))
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Once a model has been entered, named and any notes added, it can be validated and entered into
the equation library. If a backup is ever required, the equation file path is typically:

C:\Documents and Settings\All Users\Application Data\Kinetic Studio\equations.xml

Selecting a Custom Model
Scroll through the grid to select the required model. Once the line is highlighted, press 'Use
Equation' to return back to the fitting estimator and use the chosen model.

Once selected, the model is entered into the equation drop down list for convenience.

If Kinetic Studio is unable to provide any kind of estimation, it may generate an error message
and won't show a preview line in the chart window.
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Support, Updates and Suggestions
For any support enquiries, update requests or suggestions please contact TgK Scientific Limited.

TgK Scientific Limited
7 Longs Yard
Bradford-on-Avon
Wiltshire
BA15 1DH

Telephone: +44 (0)1225 868 699
Fax: +44 (0)1225 868 633

Web site:
www.hi-techsci.com
www.tgkscientific.com

Email: hi-tech@tgkscientific.com

When requesting software support that's related to a bug or error message, please provide as
much detailed information as possible.  Please note down what action was performed prior to the
issue and if deemed appropriate, please supply the dataset related to the problem.

The version of Kinetic Studio is indicated in the main starting splash screen and in the status bar
at the bottom of the application.

http://www.hi-techsci.com/
http://www.tgkscientific.com/
mailto:hi-tech@tgkscientific.com
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